
Bienvenido a la primera guía rápida de uso de GT Manager, software de edición
para la pedalera BOSS GT-6 de Roland, disponible para PC en entorno Windows.

Este programa pertenece a Partheus Software, con quienes no mantenemos relación
alguna. Esta guía rápida de usuario ha sido elaborada con total independencia de los
propietarios del software y se distribuye de manera gratuita.
Antes de instalar nada, es recomendable que conozcas en qué consiste, para qué
sirven este programa, y qué requisitos debe reunir tu equipo. Para ello, puedes y debes
visitar la web de Partheus Software: http://www.bossgt3.co.uk , donde encontrarás las
especifiaciones completas del programa, plu-ings disponibles, así como una descarga
gratuita de una versión de evaluación.
Igualmente, para adquirir la licencia que te permite disfrutar de una versión completa
del programa, debes visitar:
http://www.bossgt3.co.uk/purchase/

Ni el software, ni esta guía han sido desarrollados por Roland Electronics ni por
BOSS Corporation. De ahí que lo califiquemos de material no oficial.

Esta sencilla guía sólo pretende hacer más fácil el manejo del citado programa a
los usuarios que hablan español, y desde esta primera página , queremos agradecer en
general, a todos los usuarios del foro del GT-6 de Yahoo. La gran ayuda que significa
directamente la existencia del foro y la documentación allí disponible; suponen indirecta-
mente una gran contribución a la música.
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GUÍA RÁPIDA DE USO ( v 1.0)

Este texto pretende ser, no un completo manual de instrucciones del software GT-Manager,
sino más bien una guía rápida de cómo poder trabajar con el mismo en la edición de patches en tiempo
real y cómo poder cargar y descargar patches de nuestra pedalera, así como la mejor forma de probar
patches sin tener que cargarlos a la misma, hasta que no estemos satisfechos de los mismos y haga-
mos las modificaciones pertinentes.

CONEXIÓN MIDI

Antes de seguir adelante, hay que estar seguros de que contamos con el cable adecuado y de
que este está conectado correctamente. Si no es así, no tendremos conexión de la pedalera con el PC,
y por lo tanto el programa GT-Manager no podrá ayudarnos en casi nada.

Si nuestra tarjeta de sonido tiene entrada y salida MIDI en formato de cable DIN, necesitaremos
dos cables de este tipo que conecten el terminal IN de nuestra tarjeta de sonido con el terminal OUT de
nuestra GT-3 y por subsiguiente, el terminal OUT de la tarjeta de audio al terminal IN de la GT-3.
Si, por el contrario, como ocurre en la mayoría de los PCs equipados con tarjetas de audio de tipo
“doméstico” ( Sound Blaster y similares...), tu tarjeta de audio no tiene entrada y salida MIDI, tendrás
que procurarte un cable como este:

Se trata de un cable que conectado a tu puerto joystick de la tarjeta de sonido, te proporciona
dos terminales MIDI, uno IN y otro OUT. Puede costarte alrededor de 15 € y lo puedes encontrar en la
mayoría de las tiendas de música que tengan relación con la informática musical y en muchas tiendas
de informática.

De igual modo que como antes explicábamos, has de conectar el IN del cable al OUT de la
pedalera y el OUT del mismo al IN de la pedalera. COMPRUEBA esto bien. Si no, no funciona.
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PRIMER PASO: INSTALAR GT MANAGER v 0.1.4

Antes que nada, te recomendamos que leas detenidamente la información que encontrarás
en la web de Partheus Software ( http://www.bossgt3.co.uk )y compruebes si este software es compa-
tible con tu sistema operativo.

El Programa GTManager se se instala desde un fichero que lleva por nombre
GTManager.exe. En nuestro cd lo puedes encontrar en la siguiente ruta:
UTILIDADES - SOFTWARE\GT MANAGER 041

Lo puede ejecutar desde ahí mismo, pero para facilitar las cosas es mejor que lo copies
(Ctrl+C) y lo pegues (Ctrl+V) sobre el escritorio.

Ejecútalo haciendo doble click sobre el icono y comenzará la instalación. Pulsa el botón
Setup cuando aparezca esta ventana:

Por defecto, GTManager se instalará en el siguiente directorio, pero puedes cambiar si lo deseas:
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SELECCIONAR DISPOSITIVO MIDI

Una vez hayas instalado el programa y lo arranques, es imprescindible seleccionar correcta-

mente el dispositivo midi, para poder conseguir una correcta comunicación entre tu GT6 y el ordena-

dor. Si sólo tienes una tarjeta de audio, y no está en conflicto con ningún otro dispositivo, GT-Mana-

ger teóricamente la detectará como dispositivo MIDI por defecto, pero no está de más que lo com-

pruebes antes de seguir adelante. Si no está seleccionado el dispositivo MIDI de entrada y de salida

correctos, GT-3 Edit no podrá comunicarse via MIDI con tu pedalera, por lo que de nada no sirve

continuar.. Ve al menú Tools>Connections y te aparecerá esta ventana:

Así está configurada correctamente en el equipo en el que hemos realizado nuestra instalación. Un

PC que lleva el audio incorpoardo en la placa base. Si tu caso es diferente, has de seleccionar en

MIDI input pot y en MIDI output port, el dispositivo al que vayas a conectar tu GT6.

SEGUNDO PASO:
COPIA DE SEGURIDAD DE TUS PATCHES AL ORDENADOR

Yo empezaría por aquí. Es la mejor forma de comprobar que hay comunicación entre la salida
de tu GT6 y la entrada midi de tu tarjeta de audio.
De hecho es la primera operación que yo hice con mi GT-6 desde que abrí el GT-Manager.

Comprueba que tu GT-6 está encendida y bien conectada via midi a tu pc. No es preciso para
esto que tengas la guitarra enchufada. Para transferir datos de la GT-6 al PC o a la inversa, no es
preciso tener la guitarra conectada.

Ejecuta el programa GT-Manager y ve al menú File>Load From Gt-3/5/6
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presiónalo TRES veces seguidas hasta que en la pantalla de tu GT6 aparezca el texto:

MIDI: RX Channel
Channel = 1

Aparecerá el siguiente mensaje:

Ahora es el momento en el que tenemos que seleccionar en la pedalera el comando de transmi-
sión de datos via midi. Para ello utilizaremos el botón UTILITY
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Acto seguido, has de pulsar el botón PARAMETER >

presiónalo 13 veces seguidas hasta que aparezca en la pantalla de la GT-3 el texto:
MIDI Bulk Dump
System > Temp

Observarás que el cursor parpadea debajo de la palabra System.
Mueve un paso la rueda del dial VALUE en el sentido de las agujas del reloj y aparecerá:

# 1-1

Pulsa una vez más en
PARAMETER>

El cursor se habrá desplazado a la palabra
Temp
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Vuelve a girar una vez el dial VALUE, pero esta vez en sentido contrario a las agujas del reloj.
Aparecerá:
# 35-4

Hemos dado las instrucciones precisas a la pedalera, para que transfiera via midi a nues-
tro ordenador, todos los datos de usuario desde el patch 1-1 al patch 35-4, es decir:
TODOS LOS PATCHES DE USUARIO.

Para que esta operación se realice, hemos de pulsar el botón WRITE

observarás en la última línea de la ventana el progreso de bytes transferidos al PC.

La pantalla de tu GT6, mostrará todo el tiempo que dure la operación el siguiente texto:
MIDI Bulk Dump
Data Dumping...

Cuando la operación haya terminado, la GT-6 mostrará el mismo texto que antes de pulsar el
botón WRITE, es decir:

MIDI Bulk Dump
# 1-1 > #35-4

Podemos pulsar entonces el botón EXIT.
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La operación de volcado de datos habrá concluido y la pantalla de nuestro GT -Manager
mostrará nuestros patches de usuario

...seleccionando con un click de botón derecho cualquiera de estos patches, GT-Manager nos
mostrará, todos los parámetros y ajustes del mismo, por lo que son TOTALMENTE EDITABLES en la
pantalla del ordenador, seleccionando y modificando los parámetros directamente con el ratón...

E incluso sin usar el ratón...podemos usar elpedal de expresión par ahacer cualquier ajuste en cualqueir
efecto. basta para ello pulsar el botón

...pero a eso ya llegaremos.

Vamos, por el momento, a guardar una copia de todos nuestros patches de usuario en nuestro
disco duro, para en caso de descuido, avería, o lo que sea, poder recuperarlos en cualquier momento.
Par ello, simplemente, escogeremos el menú File>Save. esta opción y Save as, están desactivadas en
el programa si este no está debidamente registrado. para ello has de contactar con Partheus Software
en:

http://www.bossgt3.co.uk/purchase/
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TERCER PASO:

CARGAR PATCHES DEL ORDENADOR A TU GT-6

Una vez ya sabemos cómo hacer una copia de seguridad de nuestros patches de usuario, y de

este modo podemos recuperarlos en cualquier momento, aprendamos a cargar patches de otros usua-

rios a nuestra GT-6.

Podemos cargar tanto patches individualmente, como bancos completos, como colecciones

completas de otros usuarios.

Vamos a poner un ejemplo con una colección de patches que hemos descargado del foro de

Yahoo del GT-6 ( http://groups.yahoo.com/group/GT-6/ ).

El fichero en cuestión se llama PinkFloyd1_1to8_4.syx..syx y en nuestro cd del GT-6 puedes

encontrarlo en la siguiente ruta:

CD\ PATCHES-ARCHIVOS SYSEX\PATCHES EN FORMATO GT-6\ Axe Heroes\

La extensión *.syx ( ficheros midi en formato SySex) puede que no te resulte familiar hasta el momento, pero estamos

seguros que a partir de ahora se convertirán en algo de uso cotidiano ;-)

Comprueba que tu GT-6 está encendida y conectada correctamente via MIDI a la tarjeta de
sonido de tu ordenador.

Ejecuta GT-Manager y ve al menú File>Open

Si observas el contenido del fichero, se trata de una colección de patches basados en cancio-

nes de Pink Floyd que ocupan desde el banco 1-1 hasta el 8-4:
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Para cargar esta colección completa a la pedalera has de hacer lo siguiente:

selecciona el menú File >Send to GT-3

Se te mostrará la siguiente ventana:

La pantalla de la pedalera mostrará ahora el siguiente mensaje:

MIDI Bulk Load

Receiving...

La operación durará unos segundos, y al finalizar, la pedalera mostrará el mensaje:

MIDI Bulk Load

Idling...

Desde que presiones el botón WRITE en la GT6, comenzará la transferencia de datos y verás la barra
de progreso avanzar
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Está a la espera de que pulsemos el botón EXIT para abandonar la operación de carga de datos.

Mostrará por unos segundos el mensaje:

Checking data

please wait...

Cuando este último mensaje desaparezca, la pedalera se encontrará en disposición de ser

utilizada. Que disfrutes los patches!!!

Recuerda:

Los ajustes de cada usuario son diferentes y el resultado final del sonido que resulta, depende

no sólo de estos, sino también del resto del equipo ( tipo de guitarra y de amplificador, modo de co-

nexión de la pedalera a éste, el tipo de Output que tengas preseleccionado, etc).

Es muy probable que algunos o muchos de los patches que no suenan como sería de tu gusto,

sí lo hagan con el equipo de otro usuario.

De cualquier manera: Eres totalmente libre de hacer las modificaciones que estimes oportunas

y adecuadas para encontrar tu sonido ideal. GT-Manager permite hacer modificaciones directamente

en la pantalla del ordenador y escuchar el resultado en tiempo real, a la vez que tienes tu guitarra

enchufada y la GT6 conectada a tu amplificador, por ejemplo.



13

CUARTO PASO:

PROBANDO PATCHES EN GT-MANAGER SIN CARGARLOS A LA PEDALERA.

Esta es una de las posibilidades que nos parecenmás atractivas de entre las que presenta este

pequeño programa.Expliquemos por encima en qué consiste:

Si has visitado el foro de Yahoo que ya hemos citado (http://groups.yahoo.com/group/GT-6/) y

más concretamente la sección Files, habrás visto que la cantidad de patches disponibles, aportados

por los usuarios, va en contínuo aumento y que ya son unos centenares.

Si los has descargado, o tienes en tu poder cualquiera de nuestras versiones del GT-6 CD

donde se incluyen todos estos patches y algunos más, tendrás claro que si para probarlos todos fuera

imprescindible cargarlos a la pedalera, necesitaríamos reprogramarla completamente más de una de-

cena de veces.

Por ello, la posibilidad que ofrece GT-Manager de poder probar, es decir: oir cómo suenan los

patches, sin tener que cargarlos obligatoriamente a la memoria de la pedalera, se nos antoja como uno

de sus más preciados logros. De esta manera podemos buscar y elegir entre cualquiera de las colec-

ciones de patches que están disponibles, aquellos que nos parecen más adecuados al sonido que

buscamos y desechar aquellos que no nos interesan.

Echemos una ojeada al procedimiento, pero es muy sencillo.

Antes que nada, comprueba que tienes la GT-6 bien conectada via MIDI atu ordenador, que

está encendida, que tienes tu guitarra enchufada en el INPUT de la pedalera y tu ampli ( o el dispositivo

de salida que uses: auriculares, el propio ordenador, ...o lo que sea).

Ejecuta GT-Manager.Ya el entorno te resultará familiar.

Vamos a probar los patches de alguna colección de las que incluimos en nuestro GT-6 CD.

Por ejemplo, la colección de patches del fichero EricClapton1_1to1_4.syx..syx que encontrarás siguiendo

esta ruta:

CD:\PATCHES - ARCHIVOS SYSEX\PATCHES EN FORMATO GT-6\Axe Heroes\ EricClapton1 _1to1 _4. .syx

Para ello ve al menú File>open

y carga el fichero Sysex en cuestión:

EricClapton1_1to1_4.syx..syx
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selecciona, por ejemplo el patch 1-4 EC WFUL TONIGHT

CHAAAAAAAAAAAAANNNNNNNNNNNNNNNNNNN!!!!!!

Mira la pantalla de la pedalera y toca la guitarra...

Lo que la pedalera muestra ahora es el patch EC WFUL TONIGHT que no está cargado en

ella, sino que está ejecutando via MIDI desde el programa GT-Manager. Tu guitarra sonará con ese

patch hasta que con el ratón selecciones otro, y otro y otro...y así puedes ir probando todos y cada

uno de los patches de esta colección o de cualquier otra que vayas abriendo con GT-3 Edit.

EDICIÓN Y MODIFICACIÓN DE PATCHES EN GT-MANAGER

Hasta ahora hemos tratado los temas que a mi me parecen básicos o suficientes para llegar a

considerar GT-Manager como una estupenda herramienta para trabajar con esta pedalera, pero aún

hay más!!

Si ya probar los patches sin necesidad de cargarlos a la memoria de la pedalera ( tal como vimos en

el anterior apartado) ya es una gran ventaja, lo que realmente me pareció otro mundo cuando empe-

cé a conocer y usar este software, es la posibilidad de EDITAR patches en tiempo real a la vez que

toco la guitarra y voy oyendo cómo suenan las modificaciones que hago en pantalla con el ratón.

Diré primero que mi experiencia con pedaleras no es corta. Si hago memoria, creo que he

tenido unas cinco de varias marcas. Entre las programables que conozco, con la posibilidad de

edición de patches, uno de los grandes logros y engorros, es precisamente la programación.

Para «fabricar» un sonido determinado hay que estar navegando por un sinfín de menús y

submenús con el consiguiente hecho de estar agachándose a pulsar botoncitos y la mayoría de los

usuarios que conozco, terminan con la pedalera sobre sus rodillas (sustituyendo la posición más

«natural» para ser ocupada por su guitarra) y haciendo leves modificaciones en los «patches de

fábrica» o presets. La GT6 pretende evitar esto, en parte con la inclusión de potenciómetros para

una rápida edición de los parámetros más habituales, pero en mi caso, nunca he sido partidario de

estos potenciómetros

No soy el primero que afirma que los presets de la GT-6 de Boss no son nada del otro mundo.

De hecho tan sólo unos cuantos me han parecido útiles. Igualmente me ocurría con la GT-3

Claro está que yo consideré siempre los presets como una especie de «tarjeta de presentación

del producto» por parte del fabricante, de manera que lo que muestra no es más que un abanico de
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matices capaces de llegar a un mayor número de gustos estilísticos posibles. Hacer «vendible» la

GT-6, en resúmen.

La GT-6 puede llegar mucho más allá de lo que someramente muestra en los presets, pero

hasta que conocí GT-Manager, el tener que hacer un determinado programa era todo un suplicio, y

terminaba haciendo pasos intermedios y primeras y segundas versiones de un mismo patch que no

me atrevía a sobreescribir, por miedo a no poder deshacer.

Esto se acabó y ahora, programo y edito con muchísima facilidad, con la pedalera siempre en

el suelo (el mejor sitio) y a la vez que toco la guitarra.

Sólo quito la mano de las cuerdas para hacer el gesto necesario para mover el ratón para un

nuevo ajuste.

Pongamos un ejemplo:

Tenemos la GT-6 enchufada y encendida, conectada vi MIDI al ordenador, a nuestra guitarra y

a nuestro amplificador.

Volvamos a usar el fichero 1-4 EC WFUL TONIGHT.

...ya sabemos como abrirlo, desplegarlo y tenerlo en pantalla.
Si hacemos click con el botón derecho del ratón sobre el citado patch, se nos muestra una ventana

en la que podemos editar cada parámetro que conforma este patch.

Cualquiera de las modificaciones que hagamos afectará en tiempo real al patch que estemos editan-

do, es decir, podemos oir estas modificaciones al mismo tiempo que las hacemos.

Y hasta aquí esta pequeña guía que te ayudará a iniciarte en el manejo de GT Manager. Podríamos

tocar más temas, pero tú mismo verás que el manejo de este software es muy sencillo. Desde que lo

hayas usado dos o tres veces, no tendrá secretos.


